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1. Welcome to Rooms for Windows 

Full Screen 
Room for DOS 
Application 

Overview display 

Rooms™ for Windows from XSoft is an add-on program that operates in 
the Microsoft® Windows™ environment. It complements Windows by 
providing multiple virtual desktops, called rooms. These rooms allow 
you to group your work activities by client, project, task, or any way you 
want. 

Rooms for Windows lets you experience the full power of the Windows 
environment through multiple desktops. It's almost like running multi
ple sessions of Windows at one time. Instead of having just one desktop, 
you can have two or more - each in a separate room. 

Rooms containing 
Windows applications 

shows all rooms ----t-

Rooms for Windows 

Figure 1. The Overview shows all your rooms at a glance. Each room is a desktop containing 
applications and files. 
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Some of the advantages of using Rooms for Windows are: 

• Rooms for Windows lets you dedicate rooms to different aspects of 
your work, making it easy to find applications and unclutter your 
screen. You can have a room for each task, client, or project you 
support. 

• Rooms for Windows opens applications automatically and loads 
the files you designate, which improves your productivity. Each 
time you enter a room, all applications, files, and objects are just 
as you left them when you were there last. 

• Rooms for Windows lets you place data file icons (called document 
buttons) on the desktop to visually organize your work. Buttons 
save memory space by running applications only when you need 
them. 

• Rooms for Windows saves rooms in groups called suites. You can 
have any number of rooms in a suite. If more than one person uses 
your PC, each person can use a different suite. 

• Rooms for Windows lets you dedicate an entire full-screen desktop 
to applications that do not normally run under Windows. 

Taking a closer look at rooms 

Each virtual desktop in Rooms for Windows is called a room, and a group 
of rooms is called a suite. You can view all the rooms in a suite in the 
Overview display as illustrated on the previous page. From the Over
view display, you can easily find, copy, and move applications between 
rooms, create or delete rooms, and go to rooms. You can also load new 
suites and get extensive on-line help. 

To open and use applications in a room, you must go to the room first by 
using a menu command or the mouse. When you go to a room, the room 
occupies the entire screen (like a regular Windows desktop) as il
lustrated on the next page. Once inside a room, you can start applica
tions in the normal way from the Program Manager or from icons called 
buttons. 

Rooms for Windows 
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Figure 2. Rooms are virtual desktops that contain applications, doors and buttons. 

In addition to the usual Windows objects, a room contains one or more 
icons unique to Rooms for Windows. Every room contains an icon called 
a Back Door. The Back Door takes you back to the room (or Overview 
display) from which you just came. It also contains a menu of important 
commands, including Help. 

Rooms for Windows 

Rooms may also contain icons called doors and buttons. Doors take you 
to other rooms. Buttons execute DOS commands or open data files and 
their applications. These icons also contain a menu, similar to a window 
control menu. 

3 
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This guide assumes that you are already familiar with Microsoft Win
dows commands and operations such as selecting menu commands, 
working with applications, and operating in the Program Manager. If 
not, this information is covered in the Microsoft Windows User Guide. 

You'll also find it helpful to be familiar with DOS commands, and 
directory, pathname and filename conventions. For this information, 
refer to the DOS User Guide that came with your computer. 

Starting to use Rooms for Windows 

The information in this guide will step you through installing and 
starting to use Rooms for Windows. In addition, the program itself 
contains extensive on-line help. 

• Section 3 - Provides requirements for hardware and software, 
along with other important considerations. 

• Section 4 - Provides installation instructions. 

• Section 5 - Provides a guided, hands-on tour through some of the 
basic features of Rooms for Windows. 

• Section 6 - Provides an overview of the process for setting up your 
own rooms. 

• Sections 7 through 12 - Contain procedures for using Rooms for 
Windows. 

• Section 13 - Provides helpful hints and tips. 

Rooms for Windows 



3. Hardware and software requirements 

3. Hardware and software requirements 

To install and run Rooms for Windows, you need: 

• Microsoft Windows version 3.0 or later 

• PC using a 80286 or higher microprocessor 

• 2MbRAM 
• Disk drive: 5 114" (1.2 MB) or 3 112" (720 K) 

• EGA, VGA, 8514/A, or compatible video graphics adapter and 
monitor 

• A mouse is recommended. 

Important restrictions: please read 

Memory 
management 

Real Mode 

Number of 
open 

applications 

Shells 

Rooms for Windows 

This section describes restrictions for using Rooms for Windows. 

Rooms for Windows is an application that runs in Windows. It is not a 
TSR (terminate but stay resident) program. It runs in a small portion of 
RAM and does not require any special or additional memory manage
ment device drivers beyond the memory managers already installed for 
DOS and Windows. 

While Rooms for Windows can run in Windows Real Mode, the resource 
limitations of Windows Real Mode make the use of Rooms for Windows 
of little value. You should only run Rooms for Windows in Standard 
Mode or 386 Enhanced Mode. 

The limitations on the number of applications you can have open at one 
time is the same as in Windows. If you are running Microsoft Windows 
version 3.0, you should be able to open up to 15 applications. If you are 
running Windows 3.1, you should be able to open up to 30 applications. 
The exact number that you can have open at one time depends on the 
applications. Rooms for Windows will give you a warning if it deter
mines you are running low on memory or Windows resources. 

The use of Program Manager, rather than other shells for Windows, is 
highly recommended. 

5 
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If you have not installed Microsoft Windows version 3.0 or later on your 
PC, you must do so before installing Rooms for Windows. 

Note: Even if you usually use a different "shell" to run applications, 
such as the File Manager for Windows, you are advised to use the 
Program Manager to install Rooms for Windows. 

To install Rooms for Windows: 

1. Start a Windows session. 

2. Open the Program Manager if it's not already open. 

3. Insert the Rooms for Vlindows prograTll disk in the disk drive you 
are using for the installation (usually drive A:). 

4. Choose Run from the Program Manager File menu. 

5. Enter: A:SETUP.EXE (If you are using a disk drive other than A:, 
substitute the drive letter for A.) 

6. Choose OK. 

The Setup dialog box appears. 

7. Enter a new pathname if you want to install Rooms for Windows in 
a directory that is different from the default directory. 

8. Choose OK. 

The install program automatically creates a program group and 
application icon for Rooms for Windows. A dialog box appears telling 
you that the program group is created and that installation is com
plete. 

9. Choose OK. 

10. If you want to start Rooms directly from DOS, edit your 
AUTOEXEC.BAT to include the Rooms directory in your PATH 
statement. (See Section 7 for more information.) 

For example: PATH = C: \DOS;C: \ WINDOWS;C: \ROOMS; 

Rooms for Windows 
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5. A quick tour of Rooms for Windows 

Rooms for Windows 

This quick tour guides you through the basics of moving through the 
Rooms for Windows environment, creating rooms, and placing applica
tions in rooms. 

If you are a new Windows user, you'll find the tour very helpful. If you 
want to begin using Rooms for Windows immediately, skip to section 6, 
"Working with Rooms for Windows." 

To start the Rooms for Windows program from Windows: 

1. Open the Program Manager. 

2. Double-click the Rooms for Windows program group icon, or select 
the Rooms for Windows program group. 

3. Double-click the Rooms icon. 

For a short time you will see windows opening and objects moving 
about on your screen as each application is opened and set up. 

The first time you begin a Rooms for Windows session, a group of rooms 
known as the default suite appears on the screen. This view of all the 
rooms in a suite is called the Overview display. Each room represents a 
separate Windows desktop, even though only one instance of Windows 
is running. 

Each room's title 
shows the 

room's name 

Figure 3. Every room in a suite appears as a small desktop in the Overview display. 
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The default suite consists of two rooms: Room 1 and the Overlay room. 
Room 1 contains the Windows Program Manager, an open application 
that displays release information, and several buttons and doors. The 
Overlay room is a special room, because its contents automatically 
appear in all other rooms. 

The Windows Control menu box appears in the top left corner of the 
Overview display. Only the Close command is available. When you 
choose it, you end your Rooms for Windows session and return to the 
Windows desktop. 

Each room can contain the Program Manager and the following objects: 

• Application windows - Both restored and minimized windows 
and their applications are supported. 

• Program buttons - These are icons that can start applications 
and run DOS commands. 

• Document buttons - These are icons that open files and the 
application programs used to create and edit the files. 

• Doors - These are icons that you can use to move between rooms 
or to the Overview display. 

• Back Door - This is a special door that always leads to the room 
from which you came or to the Overview. It also displays a menu 
of useful commands you can use in a room. 

Viewing objects from the Overview 

In the Overview display, you can expand the obj ects in the rooms for a 
better look. This is useful for locating your work or applications, but 
you'll need to move to the room where the object is located before you 
can use the object. 

Try expanding some objects in the Overlay room: 

1. Point to the Program Manager window in the room labeled 
"Overlay," and then double-click the left mouse button. 

The Program Manager expands to full size. 

Rooms for Windows 
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1:1 Rooms for Windows - default.ste 
file Booms Windows !:!.elp 

Rooms for Windows 

Games 

~ 
~ 

Readme Files 

Windows Applications Accessories Non·Windows Applications 

Figure 4. Double-clicking on the Program Manager expands it to full size. 

2. Click the left mouse button (or press any keyboard key). 

The Program Manager window reduces to its former size. 

3. For practice, expand the small icon in the top left corner of the 
Overlay room, then reduce it. 

The Clock expands and then reduces. 

In addition to the Clock and Program Manager applications, the Overlay 
room contains two doors. The objects in the Overlay room are automat
ically included in Room 1. Room 1 also has an additional open applica
tion (the Write application), another door, and a button. 

When objects are included from another room, the borders of included 
objects are shown in green in the Overview display. 

The border color of the original applications that you open, doors and 
buttons that you create in a room, and copies of these objects are shown 
in gray. When you select an object, its border color changes to red. 
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Moving into rooms 

I 
D:or 

To use the objects in a room, you must move into the room. For example, 
if you want to use a word processing application, you need to move into 
the room containing the application. 

To move to a room from the Overview display, you can use the Go To 
command in the Rooms menu, or double-click on the room's title bar. 

Try moving to a room: 

1. Point to Room l's title bar and double-click the left mouse button. 
(Clicking once only selects the room.) 

You go to Room 1, which looks similar to the following illustration. 

Welcome to Rooms for Windows 

Whats NEW with this release (1.0): 

Important Note 

Rooms for Windows has NO special requirements regarding PATH, 
AUTOEXEC.BAT CONFIG.SYS, orWIN.INI entries. Rooms for Windows 
makes NO modifications to any of these files or variables. 

Figure 5. Room 1 contains the open ROOMINFO.WRI document. The room name is 
shown in the lower right corner of the screen. 

Room 1 contains several doors. Doors take you to another room or to the 
Overview display. Each door is labeled with the name of its destination. 

To go through a door, you can double-click the door or select the Restore 
command from the door menu. The door menu displays when you point 
to the door and click the left mouse button. 

Rooms for Windows 
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BackDoor 
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To move between rooms: 

1. Point to the door labeled "Overlay" and double-click the left mouse 
button. 

You go to the Overlay room. 

2. Point to the open door labeled "Room I" and double-click the left 
mouse button. 

You go back to Room 1. 

Notice that the open door in this room is labeled "Overlay." The open 
door is a special type of door, called a Back Door, which appears in every 
room. It's always labeled with the name of the room from which you 
came or the Overview. 

Double-clicking on the Back Door always returns you to your previous 
location (whether it was a room or the Overview display). 

The Back Door has a menu that provides many of the functions on the 
Overview menus, plus several additional functions useful only in a 
room. 

Move 

S:!litch To ... 
Qverview 
find 
Windows 
,9oto 
.create/Delete 

tlelp 

Ctrl+Esc 

Figure 6. The Back Door menu contains useful commands. 

For example, you can find applications, copy windows to another room, 
go to another room, and display Help. You can also use the Back Door 
menu to create new rooms, doors and buttons. 
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Creating a room 

You use the Insert key to create a room from the Overview display. While 
in a room, you use the Back Door menu to create a new room. When you 
create a room with the Back Door menu, you go to the room immediately. 

To create a room using the Back Door menu: 

1. Point to the Back Door and click the left mouse button once. 

The Back Door menu appears. 

2. Choose Go To to display the Go To sub men u. 

3. Choose Room. 

The Choose Room to Go To dialog box appears, with <new room> 
already highlighted. 

4. Choose OK. 

The Create Rooms to Go To dialog box appears. 

5. In the Room Name box, type: Room 2 

6. Choose OK. 

A new room labeled "Room 2" opens. Room 2 includes all the contents 
of the Overlay room: the Program Manager, the Clock, and a door. It 
also includes a Back Door to Room 1. 

7. Return to the Overview display by double-clicking the Overview 
door or selecting Overview from the Back Door menu. 

The Overview display now shows three rooms. 

Rooms for Windows 
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Rooms for Windows - default.ste 
.Eile Booms Windows tlelp 

Figure 7. The Overview display showing three rooms. 

Including applications in rooms 

Rooms for Windows 

When you place applications in a room, it's important to understand the 
difference between copying, including, and starting an application. 

Applications in the Overlay room are automatically included in all 
rooms. 

First, look at how included applications work: 

1. Point to the Clock icon in the top left corner of the Overlay room, 
then press and hold down the left mouse button. (Keep the mouse 
button held down.) 

2. Drag the pointer down to move an outline of the Clock. Then release 
the mouse button. 

The Clock moves down in all three rooms. (You can use the point, 
drag, and release technique to move any object within a room or to 
another room.) 

13 
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3. Point to the Clock in Room 2 and move it up a bit. 

The Clock moves up in all three rooms. 

Since the Clock is included, all occurrences of the Clock represent only 
one running application (i.e., one instance of the program running in 
memory). Moving, sizing, or altering the Clock in any room affects all 
occurrences of the Clock. Use the include feature when you want an 
application to remain in the same condition from room to room. 

Objects such as windows, buttons, and doors do not have to be in the 
Overlay room to be included. You can include the contents of any room 
in any other room by using the Include command in the Rooms menu. 

To include all of the objects in Room 1 in a new room: 

1. Create a new room by choosing New in the Rooms menu at the top 
of the Overvie'.v display. 

2. Type: Room 3 and choose OK. 

The new room is created and the Overview display shows four rooms. 

3. Click once in the title bar of Room 3 to select it as the destination of 
the Include operation. 

4. Choose Include from the Rooms menu. 

The Choose Room to Include From dialog box appears. 

5. Select Room 1, and then choose OK. 

The objects in Room 1 are included in Room 3. 

Copying applications to rooms 

If you copy an application from one room to another, the copy can be 
moved, sized, or altered independently of the source. To demonstrate 
that copied applications can be moved and sized separately, you will copy 
the Write application in Room 1 to Room 2. 

To copy an application: 

1. Click on the Write application window in Room 1. 

The Write application window changes color to indicate it's selected. 

Rooms for Windows 
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2. Press C on the keyboard to make a copy of the Write application. 

3. Move the pointer to Room 2 and click the left mouse button to place 
the copy. 

The Write application is copied to Room 2. 

4. Point to the Write application in Room 2, then press and hold down 
the left mouse button. (Keep the mouse button held down.) 

5. Drag the pointer around to move the application within the room, 
then release the mouse button. 

The Write application moves in Room 2, but is not affected in Room 
1. 

You can use the point, drag, and release technique to move any object 
within a room or to another room. 

Opening a separate instance of an application 

Rooms for Windows 

Copied and included applications share the same data file. If you want 
to use the same application to work on different data files at the same 
time, you need to open another instance of the application. 

To open a new instance of the Write application in Room 2: 

1. Double-click in the title bar of Room 2 to go to Room 2. 

2. Click the Program Manager to bring it to the front of all other 
windows. 

3. Find the Write application icon (in the Windows Accessories group) 
and double-click the icon to start the application. 

The Write application is started. The application window contains an 
empty, untitled file that you can use to type a new document, or you 
can load a different file. 

4. Double-click the Overview door to go to the Overview display_ 

5. Double-click the Write application in each of the rooms to expand it 
for viewing. 

The files are the same in the copied and included applications, but 
different in the newly opened application. 

15 
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It's important to remember that open applications take space in 
memory. Windows has limitations on the number of applications that 
can be open, so you'll want to keep this in mind when you set up your 
rooms. See "Number of open applications" in Section 3 and your Win
dows documentation for more information. 

To help you manage applications, Rooms for Windows provides buttons 
that allow you to create icons that reference applications in rooms 
without having the application open. Also you can carry applications 
with you automatically as you move from one room to another. These 
operations are covered in section 12. 

Summmarizing 

To summarize what you've learned: 

• Include an application when you want it to remain in the same 
location and condition from room to room. 

• Copy an application when you want to be able to move, size or 
change its state independently from room to room. 

• Start an application running again (a new instance) when you 
want to use the application for two different data files at the same 
time. 

Open applications take space in memory and Rooms for Windows ad
heres to standard Windows memory management. You can use buttons 
and include applications to help reduce the number of open applications. 

Some applications do not allow you to run multiple instances of the 
application under Windows. When you try to open one of these applica
tions for the second time, a message appears announcing this Windows 
restriction. 

Ending the quick tour 

During this tour, you have modified the default suite by adding two new 
rooms. You could save the changes to the default suite, save the suite 
using a different name, or discard the changes. To end the tour, you will 
discard the changes and return to the original content of the default 
suite. 

Rooms for Windows 
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To discard the changes you have made and return to the original default 
suite: 

1. Return to the Overview display. 

2. Choose Load Suite in the File menu. 

The Load Suite dialog box appears. 

3. Enter DEFAULT.STE for the suitename. 

4. Click Load. 

The Save Suite dialog box appears. 

5. Click No to abandon any changes you've made to the current suite 
and load the original default suite. 

This completes the Quick Tour. Before you begin working with Rooms 
for Windows, you will find it helpful to review additional features 
described in Help. Refer to the Section 8, "Using Help" for more infor
mation. 

If you want to exit Rooms for Windows, refer to the exiting options in 
Section 7. If you want to begin organizing your own applications in 
rooms, continue on the next page with Section 6. 

17 
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This section will to help you organize your rooms in a way that matches 
your workflow and makes you more productive. It points you to sections 
in the guide where you can find the detailed information you need. 

Deciding how to organize your rooms 

The first thing you need to do is decide how you want to organize your 
rooms. 

Rooms for Windows excels at allowing you to organize and easily modify 
the way you work. Following are some examples of how you might want 
to organize your rooms: 

• Task-oriented organization - An accountant might create a 
room for a data base application, create another room to keep 
electronic forms with a forms program, and create a third room to 
contain a spreadsheet application. 

• Client-oriented organization - A marketing representative 
might be in charge often major accounts and a few minor accounts. 
The representative could create a separate room for each major 
account and a single room for all the minor accounts. 

Files for each account could be made into· document icons and 
placed in the account's room. Applications used for all accounts 
could be placed in the Overlay room making them available in all 
rooms. 

• Project-oriented organization - Engineers often work on 
several new projects at the same time and perform maintenance or 
fixes on projects that have been released for production. 

The data files for each project could be maintained as document 
buttons in separate rooms while applications such as program
ming tools, might be located in separate rooms. 

Rooms for Windows 
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Setting up your Rooms 

Rooms for Windows 

Following is an overview of the process for setting up your first suite of 
rooms. 

• Creating the rooms you need - Mter deciding how to organize 
your work, you can create as many rooms as you need. When you 
start Rooms for 'Vindows the first time, the default suite contain
ing an Overlay room and Room 1 appears. Use this suite to start 
creating your own rooms. 

See Section 9, "Creating and editing rooms and suites" for more 
information. 

• Creating doors - After creating rooms you can add doors to 
individual rooms. These doors allow you to move directly from one 
room to another. If you want the same door available in all rooms, 
create the door in the Overlay room. 

See Section 11, "Creating and editing objects." 

• Creating Buttons - While in any room, you can create document 
and program buttons that can open files and start applications on 
demand. To avoid having open applications in each room, you can 
use buttons which open applications and files only when you select 
them. 

See Section 11, "Creating and editing objects." 

• Opening applications - Go to each room and start applications 
that you want open all the time. If you want to include the same 
application in all rooms, place it in the Overlay room. 

See Section 11, "Creating and editing objects." 

• Creating full-screen rooms - If you have full screen DOS ap
plications you want to run, you can create buttons that start them 
or you can place the application in a full screen DOS room that you 
open from the Overview display. 

See Section 13, "Accessing DOS from Rooms for Windows." 
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• Saving your suite - You can save your suite as the default suite 
so that it will be loaded each time you enter Rooms for Windows. 
If you will be using more than one suite of rooms, you'll want to 
save suites using different names. / 

See "Creating and saving suites" in Section 9, "Creating and 
editing rooms and suites." 

• Loading your suite - If you saved your suite as the default suite, 
it will be automatically loaded when you start Rooms for Windows. 
To load other suites at start up time, use one of the alternative 
methods of starting Rooms for Windows. 

See Section 7, "Starting and quitting options" or see the informa
tion on "Loading a previously saved suite" in Section 9, "Creating 
and editing rooms and suites." 
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7. Starting and quitting options 

You can start Rooms for Windows from the Program Manager or from 
DOS as described below. 

Starting Rooms for Windows from Windows: 

To start Rooms for Windows from Windows: 

1. Open the Program Manager window and double-click the Rooms 
program group icon. 

2. Double-click the Rooms icon. 

The screen shows the Rooms Overview display. 

Starting Rooms for Windows from DOS 

Rooms for Windows 

You can also start Rooms for Windows from the DOS prompt. 

1. To start Rooms for Windows from the DOS prompt, type: 

WIN ROOMS suitename "roomname" 

suitename and roomname are optional. roomname is case sensitive 
and must be in double quotes. If you do not enter the suite name, the 
default suite is opened. 

Rooms for Windows suite names have the file extension .STE. You don't 
need to add the extension when you enter the suite name. The default 
suite is named DEFAULT.STE. 

The following are examples of how to start Rooms for Windows form the 
DOS prompt. 

WIN ROOMS - Opens the Rooms default suite to the Overview 

WIN ROOMS WORDPROC - Opens Rooms to the Overview in the 
suite named WORDPROC.STE 

WIN ROOMS WORDPROC "GRAMMAR" - Opens Rooms to the 
GRAMMAR room in the suite named WORDPROC.STE. 
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Exiting Rooms for Windows 

You end the Rooms for Windows session from the Overview display. 
Ending the session will take you back to Windows. 

To quit Rooms for Windows and return to Windows: 

1. Close any open DOS applications. If you are going to save a new or 
changed suite, see "Creating and saving suites" and "Managing 
suites of rooms" in Section 9, "Creating and editing rooms and 
suites." 

2. Choose Exit Rooms from the File menu (or press Alt+ F4). 

The Save Suite dialog box appears. 

3. Choose YeS to save the suite, or choose No if you don't want to save 
the changes you have made to your suite. 

4. If you chose to save the suite, one or more Startup information dialog 
boxes may appear. Enter the appropriate startup information in 
each of the dialog boxes. For detailed information see "Supplying 
startup information" on the following page. 

Exiting Windows 

You can also end your Rooms for Windows session by leaving Windows. 

To quit Rooms for Windows and return to DOS: 

1. Close any open DOS applications. 

2. Choose Exit Windows from the File menu. 

The Save Suite dialog box appears. 

3. Choose Yes to save the suite, or choose No if you don't want to save 
the changes you have made to your suite. If you are going to save a 
new or changed suite, see "Creating and saving suites" and 
"Managing suites of rooms" in Section 9, "Creating and editing 
rooms and suites." 

4. If you chose to save the suite, one or more Startup information dialog 
boxes may appear. Enter the appropriate startup information in 
each of the dialog boxes, as described in the following information. 

Rooms for Windows 



7. Starting and quitting options 

Supplying startup information 

Rooms for Windows 

Separate Startup information dialog boxes appear for each application 
you started for the first time in the current session. The dialog box lets 
you verify the application's startup command and optionally select a 
data file to open with the application. The dialog box also re-appears 
when you change an application's window name (usually this indicates 
the data file has changed.) 

Although Rooms for Windows enters the Startup command automat
ically for Windows applications, commands for DOS applications must 
be entered manually. Some Windows applications substitute different 
extensions or add other data to the command. Therefore, always verify 
that the startup command line is correct, and edit where necessary. If 
you don't think the command is correct, you can use the Browse feature 
to search for the correct command. 

Enter startup info for the window titled: 

Notepad - (untitled) 

~elected Data File: 

files in c:\windows 

write.hlp 
xlsetup.exe 
[ .. ) 
[excelcbt] 
[library) 
[system] 
[temp) 
[-a-) 
[-b-] 
I [-c-] 

Startup !;.ommand Line: 

Qk I 

No File 

,C.ancel J 

[] 

I C:\WINOOWS\NOTEPAD.EXE 

Figure 8. The Startup dialog box allows you to associate a data file with an application. 

Rooms for Windows lets you associate a data file with an open applica
tion so that when you start the application in the next session, the data 
file is automatically opened. 
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If you use many different files with a Windows application, you may 
want to use the No File option to start the application without a data 
file. 

If you don't want to have a particular data file opened automatically 
when you start the next session, simply click the No File button. 

When you select No File in the Startup information dialog box, the 
Startup dialog box will not appear again for the application. This is 
useful for applications that often change window titles, such as clocks 
and memory meters, or when you work with a variety of files. 

To associate a data file with an application for the next session: 

1. Select the file from the scrolling list. (If the data file you want is not 
located with the application, references to different disks and 
directories appear at the bottom of the list.) 

The file name appears in the Selected Data File box. 

2. Verify that the command line entry in the Startup information 
dialog box is correct. If not, edit the command. 

3. Click OK. 

When you enter startup information for a DOS application, it keeps the 
application available in a full screen room. 

To keep DOS applications available in full screen rooms: 

1. If you want to associate a data file with the application, select a data 
file from the scrolling list. 

2. Verify that the command line in the Startup information dialog box 
is correct. If not, edit the command. 

3. Click OK or click No File if a data file is not required. 
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8. Using Help 

Rooms for Windows has comprehensive, context-sensitive help informa
tion. You can access help by: 

• Pressing the Fl function key 

• Choosing a command in the Help menu 

• Choosing a command in the Back Door Help sub menu 

• Clicking the yellow question mark in a dialog box. 

If you're viewing a help screen, you can press Fl to display the Using 
Help screen. It provides information on how to use help. 

Using the Help menu 

Rooms for Windows 

Click on Help in the menu bar in the Overlay display to display the Help 
menu for Rooms for Windows. An abbreviated version of the menu is also 
available in the Back Door menu in each room . 

.Glossary ... 
How To ... 
Using Help ... 

About. .. 

Figure 9. The Help menu is organized like Windows Help and accessed directly from the menu 
bar. 

The following is a description of the commands in the Help menu: 

• Index - Lets you choose from a list of general help topics. 

• Glossary - Displays definitions of terms used. 

• How To - Presents a menu of specific task topics. 

• Using Help - Explains the organization of Rooms Help. 

• About - Displays a dialog box containing version information for 
Rooms for Windows. 
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The Help screen 

When you select a command from the Help menu, a help screen appears 
in the standard Windows help shell. The window displays the normal 
Windows Help menus, control buttons, and text screen that can contain 
cross-references and terms. 

Figure 10. Along with hypertext cross references, the Help control buttons and menus help 
you navigate through Rooms help. 

Menu bar The menu bar contains the standard Windows help menus. 

• File menu - Contains commands that allow you to print the 
current topic, open another help file, or close the current file. 

• Edit menu - Contains commands that allow you to annotate 
Rooms help. You can write notes that are saved with the help file. 

• Bookmark menu - Contains commands that allow you to create 
and return to bookmarks that you place within help. 

• Help menu - Goes to the Windows help screen. 

Control buttons The control buttons provide the standard Windows navigation com
mands. 
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• Index button - Click the Index button to return to the Rooms for 
Windows Help main index. 

• Back button - Click the Back button once to return to the last 
help screen. Continue clicking the button to see other screens you 
have viewed in this help session, in reverse order. 

• Browse buttons - Click the Browse Forward and Browse Back
ward buttons to view the next or previous screen within the 
current section of related help screens. 

• Search button - Click the Search button to display a dialog box 
with a list of keywords that relate to specific topics within help. 
Double-click on a keyword to display the list of related screens, 
then select the screen you want to view. 
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Screen text The text within the screen can contain a control word that allows you to 
jump to other screens or display related terms and graphics. 

Rooms for Windows 

• Cross references - Within the help text, certain words appear in 
green (on color monitors) and are underlined. Words with a solid 
underline are cross references. When you click one of these words, 
you jump to another help screen that explains the word. 

• Terms/graphics - Words with dotted underlining display glos
sary term definitions and graphic illustrations such as dialog 
boxes. When you position the mouse pointer over these words and 
hold down the left mouse button, help information appears as 
shown in the following illustration. 

The Save Suite ... command in the f.lh;".m~m.\!. 
saves the current suite as the default suite. 

Procedure: 

1. Click Save Suite ... in the File menu or 
press F2 while in the Overview display. 
The "Save Suite" qi<;l~I;i·{lr·;;;_a.pp=ea=rs=. ____ ·111" !!!= ____ _ 

2. Click (No] to close\h~ 
saving the suite. 

Click (Yes] to save th 
Rooms default suite. 

Click (Cancel] to clos 

Save Suite 

Save suite to file default.ste? 

Figure 11. When you press the left mouse button, the referenced information appears. 
When you relaease the mouse button, it disappears. 
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Rooms for Windows also has context-sensitive help, which displays help 
for the current area of the application. 

Press the Fl key to display help for: 

• Menu commands - Click a menu in the Overview, or an object in 
a room to display a menu. Then use the keyboard arrow keys to 
highlight the command and press Fl. 

• Message boxes - Press Fl when the message box is displayed. 

• Dialog boxes - Press Fl with a dialog box displayed, or click the 
yellow question mark button. 

• Icons - Select the minimized icon and then press Fl. 

• Door§ = Select the door and then press Fl. 

• Buttons - Select the button and then press Fl. 

If you press Fl while in a help screen, you go to the "Using Help" screen 
for Rooms for Windows. 
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9. Creating and editing rooms and suites 

This section provides information about: 

• Creating, renaming, and deleting rooms 

• Creating and loading suites 

• Changing room backgrounds. 

You can add, delete, and rename rooms in any suite, although you 
cannot delete the Overlay room. Rooms for Windows automatically 
resizes and repositions the current rooms on the Overview display as 
you create, add or delete rooms. 

In the Overview display, the rooms appear in alphanumeric order, left 
to right, top to bottom. You can add as many rooms to your suite as you 
need. Rooms can be named with any combination of up to 24 alphabetic, 
numeric, or special characters. 

Creati ng rooms 

Rooms for Windows 

You can create rooms four ways: 

• Use the New command in the Rooms menu while in the Overview 
display 

• Press Ins (Insert key) on the keyboard while in the Overview 
display 

• Choose CreatelDelete Room in the Back Door menu while in a 
room 

• Use the Go To dialog box that appears when you double-click the 
right mouse button in an unoccupied space while in a room. 

To create a room using the Rooms menu in the Overview display: 

1. Choose New from the Rooms menu. 

2. Type a name for the new room. 

The Create A Room dialog box appears. 

3. Choose OK. 

The new room is created and appears in the Overview display. 
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To create a room using the Insert key on the Overview display: 

1. Press the Insert key. 

The Create A Room dialog box appears. 

2. Type a name for the new room. 

3. Choose OK. 

The new room is created and appears in the Overview display. 

To create a room using the Back Door menu while in a room: 

1. Click on the Back Door. 

2. Choose CreatelDelete from the Back Door menu. 

3. Choose Create Room from the Create/Delete submenu. 

The Create A Room dialog box appears. 

4. Type a name for the new room. 

5. Choose OK. 

The room is created, but you remain in your current room. You won't 
see the new room until you move back to the Overview display or go 
to the new room. 

To create a room using the mouse while in a room: 

1. Double-click the right mouse button in an unoccupied space to 
display the Choose Room To Go To dialog box. 

2. Choose OK (new room is already chosen). 

3. Type a name for the new room. 

The Create A Room dialog box appears. 

4. Choose OK. 

You automatically move to the new room. 
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Changing room background colors and patterns 

Rooms for Windows randomly selects colors for room backgrounds. If 
you use a color monitor and would like to select your own room colors, 
use the Control Panel in the Windows Program Manager to select 
custom colors for your rooms. Patterns and bitmap backgrounds can be 
specified using the Desktop in the Control Panel. This information is 
saved with the suite file and restored the next time you load the suite. 

Renaming rooms 

You can rename any of the rooms, except the Overlay room. 

To rename rooms, begin in the Overview display: 

1. Click once on the title bar of the room you want to rename. 

2. Choose Renam.e from the Rooms menu (or press Ctrl+ R). 

The Rename dialog box appears. 

3. Type the new name of the room. 

4. Choose OK. 

The room appears with its new name; the position of the room may 
change if necessary to show it in alphabetical order. 

Deleting rooms 

Rooms for Windows 

You can delete any room except the Overlay room. 

To delete a room while in the Overview display: 

1. Click once on the title bar of the room you want to delete. 

2. Choose Delete from the Rooms menu (or press Del). 

The Delete Room dialog box appears to verify that you want to close 
the open windows in the room. 
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3. Choose OK. 

The room is deleted and the rooms in the Overview are rearranged to 
fill the gap. 

To delete a room from within another room: 

1. Click on the Back Door. 

The Back Door menu appears. 

2. Choose CreatelDelete from the Back Door menu. 

3. Choose Delete Room from the CreatelDelete submenu. 

4. Choose a room from the Choose Room To Delete dialog box. 

The Delete Room dialog box appears. 

5. Choose OK. 

The other room is deleted. 

Managing suites of rooms 

Rooms for Windows stores one suite as its default suite using the 
filename DEFAULT.STE. Unless you specify a suite in the Windows 
startup command, the default suite of rooms automatically appears 
when you start a Rooms for Windows session. The File menu in the 
Overview display contains commands for managing suites. 

New ... 
.load Suite ... 
Save Suite... F2 
Save Suite As... CtrltF2 

Exit Booms... AlttF4 
E~it Windows ... 

Figure 12. The suite management commands in the File menu allow you to create, save, and 
load suites. 
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The following is a description of the commands in the File menu: 

• New - Lets you create a new suite starting with the default suite. 

• Load Suite - Displays a list of suite (.STE) files that you can load. 

• Save Suite - Saves the suite to the current name. 

• Save Suite As - Lets you save the current suite under a different 
suite name. 

• Exit Rooms - Quits Rooms for Windows and goes to Windows. 
(See "Exiting Rooms for Windows" in Section 7.) 

• Exit Windows - Quits Rooms and Windows. (See "Exiting Win
dows" in Section 7.) 

Suite naming conventions 

Names for suite files generally follow the DOS rules for file names. 
However, you cannot use the following characters in suite names: 

• Single quote (') 

• Double quote (") 

• Open parentheses (0 
• Close parentheses 0) 

• Space. 

Creating and saving suites 

Rooms for Windows 

As the need arises, you can create new suites of rooms. If you start with 
the default suite, each new suite you create initially contains only Room 
1 and the Overlay room. 

To create a new suite: 

1. Start Rooms for Windows 

The default suite appears. 

2. Choose New from the File menu. 

A new suite appears consisting of the Overlay room and Room 1 
appears. (This new suite is not the default suite.) 
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3. Edit the suite, creating new rooms and objects as you wish. 

4. Choose Save Suite As from the File menu. 

The Enter File Name to Save Suite dialog box appears. 

Rooms for Windows 

Enter file name to save suite to: 

I C:\ROOMS\mmI!.ste 

Save I I !;.ancel J[J 
Figure 13. The Enter File Name To Save Suite dialog box appears. 

5. Enter a new suite name in the box. 

6. Click Save. 

The suite is saved under a new name. A Startup dialog box will 
appear for each application that you started for the first time in suite. 

7. For each application Startup dialog box that appears, verify that the 
startup Command line is correct for the application. (For details, see 
Supplying start information in Section 7.) Then do one of the 
following: 

• Click No File if you do not want a data file to be loaded with the 
application each time you use the suite. 

• Select a file from the list and click OK to have a file loaded in the 
application each time you load the suite. 

To save a suite using its current name: 

1. Choose Save Suite from the File menu (or exit Rooms for Windows). 

A Save Suite dialog box showing the current suite name appears. 

Save Suite 

o Save suite to file default.ste? 

I lie's] I I No I I Cancel I 

Figure 14. The Save Suite dialog box appears. 
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2. Click the Yes button. 

3. For each application Startup dialog box that appears, verify that the 
startup Command line is correct for the application. (For details, see 
Supplying start information in Section 7.) Then do one of the 
following: 

• Click No File if you do not want a data file to be loaded with the 
application each time you use the suite. 

• Select a file from the list and click OK to have a file loaded in the 
application each time you load the suite. 

Loading a previously saved suite 

Rooms for Windows 

You can load a new suite from within Rooms for Windows as described 
below. You can also specify a specific suite to be loaded when you start 
Rooms for Windows from DOS as explained in Section 7, "Starting and 
quitting options." 

Note: If you load a suite that automatically opens an application and 
. that application prompts you for a response, Rooms waits 60 seconds 
before continuing to load the suite. 

To load a different suite while in Rooms for Windows: 

1. Click Load Suite in the File menu. 

The Load Suite dialog box appears. 

2. Enter the name and path of the suite you want to load. Suites have 
a .STE file extension. 

3. Click Load. 

The Save Suite dialog box appears. 

4. Click Yes to save any changes to the current suite before loading 
another suite or, click No to abandon any changes you've made to 
the current suite and load the specified suite. 
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This chapter contains information about: 

• Moving to a room from the Overview display 

• Moving to a room from another room 

• Finding and moving to ap!plications placed throughout the suite. 

Going to a room from the Overview display 

From the Overview display, you can move to a room by double-clicking 
the room's title bar or using the Rooms menu . 

....... ....... ......... . ..... ..... ...... , ................................... " 
:r··ff©···o··"fr~········f····························· ............................................................. . 

~.T ~rogram Manager ::::: 
..... ...... ..... ..... ........... ....... ...... ..... ............ .... ...... ..... ...... ..... ..... ···········1 

::::::: Write - ROOMINFO.WRI 
....... I I 

Figure 15. Double-click the title bar. 

To move to a room using the title bar: 

1. Double-click the title bar of the room to which you want to go. 

You go to the room selected. 

To enter a room using the Rooms menu: 

1. Choose Go To from the Rooms menu (or press Ctrl + R). 

If a room is not selected, the Choose Room To Go To dialog box 
appears. If a room is selected, you go to the room. 

2. If the Choose Room To Go To dialog box appears, select a room from 
it and choose OK. 

You go to the selected room. 
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Moving to a room from another room 

Starting from inside a room, you can move to another room using: 

• The Back Door 

• The Back Door menu 

• Doors 

• The mouse pointer 

• The Choose Room To Go To dialog box. 

Moving to a room using the Back Door 

I 
BackDoor 

The Back Door is a direct passage back to your previous location. When 
you enter a new room, the Back Door appears as an opened door icon 
labeled with the name of the room you just left. When you enter a room 
from the Overview display, the Back Door takes you back to the Over
view display. 

To return to your previous location: 

1. Double-click on the Back Door. 

Moving to a room using the Back Door menu 

Rooms for Windows 

You can move to another room using the Back Door menu. 

Move 

S~itch To ... 
Qverview 
find 
Windows 
yoto 
.c.reate/Oelete 

Help 

Ilk ••• 

Ctrl+Esc 

Figure 16. The Back Door menu appears when you click on the Back Door. 
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To go to a room using the Back Door menu: 

1. Click on the Back Door. 

The Back Door menu appears. 

2. Choose Go To from the Back Door menu. 

3. Choose Room from the Go To submenu. 

4. Choose a room from the Choose Room To Go To dialog box. 

5. Choose OK. 

Using doors 

I 
CbJr 

Doors are direct passages to rooms in the suite. When you create a door, 
the closed door icon labeled with the name of the destination room 
appears in your current room. When you double-click the door icon or 
select Restore in the door menu, you move to the destination room. 

To create a door from within a room: 

1. Click on the Back Door. 

The Back Door menu appears. 

2. Choose CreatelDelete from the Back Door menu. 

3. Choose Create Door from the CreatelDelete submenu. 

4. Choose the room that you want the door to access. 

5. Choose OK. 

A door icon labeled with the name of the destination room appears in 
the room. 

To go to a room using a door icon: 

1. Double-click on the door. 

You go to the room whose name is shown under the door. 
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To go to a room using the door menu: 

1. Click on the door. 

The door menu appears. 

2. Choose Restore. 

You move into the room whose name is shown under the door. 

Using the mouse icon 

Rooms for Windows 

When you move the pointer to any unoccupied space near the top or 
sides of a room, the pointer changes into a mouse icon. You can use the 
mouse icon to move to the Overview display or to an adjacent room. 

To move to the Overview display using the mouse icon: 

1. Move the pointer to an unoccupied space along the top edge of the 
room. 

The pointer changes into the mouse icon. 

2. Click the left mouse button. 

You move to the Overview display. 

To move to an adjacent room using the mouse icon: 

1. Move the pointer to an unoccupied space along the left or right side 
of the room. 

The pointer changes into the mouse icon. 

2. Click the left mouse button. 

If the mouse icon is on the left side of the room, you move to the room 
shown on the left of the current room in the Overview display. If it is 
on the right you move to the next room on the right. 
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Moving to a room using the dialog box. 

You can also use the Choose Room To Go To dialog box to go to another 
room or the Overview display while in a room. 

To move to another room using the Choose Room To Go To dialog box: 

1. Double-click the right mouse button on unoccupied space in a room. 

2. Choose a destination room from the displayed list. 

3. Choose OK. 

Finding applications 

The Find command is a very useful tool when you are running many 
applications in different rooms. The command lets you quickly locate an 
application and move to it. On the Overview display, you can also mark 
an application, which will highlight in red all of the places it appears. 

From within a room, you can find and show an application to place a 
copy of it in that room. When you show an application that is currently 
in your room, it becomes the active window and moves to the front of the 
screen. This is especially useful when the application window is buried 
under a stack of other windows. 

To find and mark an application from the Overview display: 

1. Choose Find in the Windows menu (or press the F key). 

The Select Window to Find dialog box appears. 
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Select Window to Find 
fC"itfcu"i"a'to'r" ........................................................................ i 
Clock 
Notepad - [untitled) 
Paintbrush - [Untitled) 
Program Manager 
Write - ROOMINFO.WRI 

I Mark J I gO To J I ~ancel J f2] 

Figure 17. The Select Window to Find dialog box, 

2. Choose an application from the list. 

3. Choose Mark. 

All occurrences of the application are highlighted in red. 

4. Click the left mouse button to deselect the highlighted applications. 

To find and go to an application from the Overview display: 

1. Choose Find from the Windows menu (or press the F key). 

The Select Window to Find dialog box appears. 

2. Choose an application from the list. 

3. Choose Go To. 

You move to the room containing the chosen application. If the 
application exists in more than one room, a dialog box displaying a 
list of the rooms appears. 

4. If a list of rooms containing the application appears, choose a room 
name from the list, and then choose OK. 
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To find and show an application from within a room: 

1. Click on the Back Door. 

The Back Door menu appears. 

2. Choose Find. 

The Select Window to Find dialog box appears. 

3. Choose an application from the list. 

4. Choose Show. 

If the application is in the room with you, it becomes the active 
window and moves to the front of the screen. If the application is 
located in another room, a new copy of the application appears in the 
current room. 

To find and go to an application from within a room: 

1. Click on the Back Door. 

The Back Door menu appears. 

2. Choose Find. 

The Select Window to Find dialog box appears. 

3. Choose an application from the list. 

4. Choose Go To. 

You move to the room containing the chosen application. If the 
application exists in more than one room, a dialog box displaying a 
list of the rooms appears. 

5. If a list of rooms containing the application appears, choose a room 
name from the list, and then choose OK. 
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11. Creating and editing objects 

From inside a room, you can create the following objects: 

• Application windows 

• Buttons 

• Doors. 

Creating application windows in rooms 

Rooms for Windows 

To create application windows inside a room, you can use the Windows 
Program Manager. Place the Program Manager in the room where you 
want to place the application or put it in the Overlay room, to have it 
automatically appear in all rooms. 

Mter you start an application, its window appears in the room. Click the 
minimize button if you want the window to become an icon in the room. 

Figure 18. Click the minimize button in the full size window to reduce the window to an icon. 
Above, PaintBrush is reduced to an icon. 
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To create applications inside rooms: 

1. Enter a room. 

2. Start the application from the Program Manager. 

When you move back to the Overview display, the small window for your 
application appears in the room. If you minimized the window to an icon, 
the icon is visible in the room. You can now copy, move, or include this 
application in other rooms. 

Creati ng buttons 

Buttons are icons that start applications and open data files. They are 
a powerful feature that let you maximize the number of places where 
you can use applications, while minimizing the potential of running too 
many applications for your available memory and Windows resources. 

When you put application windows and icons in rooms, the applications 
are running. Each running application reduces the memory and Win
dows resources available. 

Buttons, by contrast, do not take as much space in memory as a running 
application does. They are icons that start applications only when you 
choose the button, so they don't use significant system resources until 
you click on them. Buttons also let you avoid using the Program 
Manager to start the applications. 

There are three types of buttons: 

• Program buttons - Starts an application running. 

• Document buttons - Starts an application and opens the data 
files associated with it. 

• Generic buttons - Appear when the command you entered for the 
button is not recognized as a data file or program by Windows. 

EI 
Program Document Generic 

Figure 19. One of these buttons is created when you use the Create/Delete Button 
command in the Back Door menu. 

Rooms for Windows 



11. Creating and editing objects 

The file that specifies which commands are recognized for document and 
program buttons is the Windows WIN.lNI file. The commands are 
recognized based on their file name extensions which appear in the 
[Windows] section and the [Extensions] section of this file. If the com
mand you enter is not recognized, a generic button will appear. 

You can modify the WIN.INI file so that it recognizes other extensions 
for both programs and data files. Your Microsoft Windows documenta
tion has information on modifying the WIN.INI file. 

Creating program buttons 

EI 
Program 

Rooms for Windows 

Program buttons appear as yellow buttons on the desktop in the room 
where you create them. 

You can create Program buttons to start Windows applications or run 
DOS programs which have the file extensions: EXE, COM, BAT, and 
PIF, or any other extension which you have added to the WIN.INI file. 

To create a program button: 

1. Enter a room. 

2. Click the Back Door to display the Back Door menu. 

3. Choose CreatelDelete. 

4. Choose Create Button from the CreatelDelete submenu. 

A generic button and the Button Editor dialog box appear. 
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Move 

S~itch To ... 
Qverview 
find 
Windows 
yO To ... 

Name: 

Command: 

Ctrl+Esc 

Create Boom 
Create !loor 

.• - II 

!lelete Room 

Rooms for Windows 

Button Editor 

I <REPLACE WITH A DOS COMMAND> 

Qk 

Figure 20. The Button Editor dialog box appears when you select Create Button. 

5. Click the Browse button. 

A dialog box with a browse list appears. 

Rooms for Windows 

Filename: 

I =ii ___ -----'I¢ 
Dies in c:\ 

a.ste 
autoexec.bak 
autoexec.bat 
auto exec. syd 
autouser.bak 
autouser.bat 
b ru cl 0JI.II.cx 

Qk 

I Browse I [] 

Figure 21. A dialog box with a list of files appears so you can select a program to be 
entered in the Button Editor dialog box. 
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6. Select a program file from the list. 

On the Button Editor dialog box, the program filename appears in 
the Name box. This name will appear under the button. The complete 
startup command for the program file appears in the Command box. 

7. Choose OK. 

8. Verify that the startup Command is correct in the Button Editor 
dialog box. If necessary, edit the name or command path and name 
of the program. 

9. Choose OK. 

The green generic button turns into a program button. If the generic 
button does not change into a program button, it is because the file 
extension is not in the WIN.INI file. 

You can use the generic button as a program button or you can change 
the information in the WIN.INI file to include the file extension in the 
Programs = line in the [Windows} section of the WIN.INI file. 

Creating document buttons 

Document 

Rooms for Windows 

A document button is an icon that represents a data file and its as
sociated application program. When you double-click the document 
button, it will start the application and open the file for you. 

Document buttons allow you to access applications when you need them, 
so you don't have to leave them running all the time. Each document 
button starts a completely separate instance of an application and opens 
the data file specified in the button's command line. If you have applica
tions which allow only one open instance, you need to close the applica
tion, if it is running elsewhere, before using a button that calls the 
application. 

Document buttons allow you to organize data files in rooms so that you 
can work most efficiently. 
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Figure 22. Buttons can be created to access a variety of data files and their applications. 

When you create a button, Rooms for Windows will compare the exten
sion of the file you select with the information in the WIN.INI file. 

The [Extensions] section of the WIN.INI file matches the filename 
extensions with their corresponding applications. So, for example, when 
you select a document with a file extension of. TXT Rooms for Windows 
looks in the WIN.INI file to determine what application is used with a 
.TXT file and then includes a command to start the application in the 
Button Editor dialog box. If the command is not correct for the applica
tion you want to use, you can change it in the dialog box. 

To create a document button: 

1. Enter a room. 

2. Click the Back Door to display the Back Door menu. 

3. Choose CreatelDelete. 

4. Choose Create Button from the CreatelDelete submenu. 

A green generic button and the Button Editor dialog box appear. 

5. Click the Browse button. 

A dialog box with a browse list appears. 
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6. Select a file with a document extension, such as .TXT or .WP from 
the list and choose OK. 

On the Button Editor dialog box, the name of the file appears in the 
Name box. The complete startup command for the application and 
data filed appears in the Command box, along with the directory and 
disk references. 

7. Verify that the startup Command contains the correct infromation 
for the application that you want started with your data file. Edit 
the command if needed to include the correct application and file. 

8. Choose OK. 

The green generic button turns into a document button. If the generic 
button does not change into a document button, it is because the data 
file's extension is not in the WIN.INI file. 

You can use the generic button as a document button or you can 
change the information in the WIN.INI file to include the file exten
sion in the Documents = line in the [Windows} section of the file. 

To associate the data file's file extension with an application, you 
need to make an entry for the file extension in the WIN.INI [Exten
sions} section. 

USing buttons 

Rooms for Windows 

After a button has been created: 

1. Double-click on the button to start the application and/or open the 
file. 
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Editing buttons 

You can edit existing buttons to change their names or startup com
mand. 

To edit existing buttons, begin in a room: 

1. Click once on a button. 

2. Choose Inspect Button Definition from the displayed menu. 

Rooms for Windows 

Button Editor 

Name: 

I Memo Template 

Command: 

I NOTEPAD.EXE C:\MEMO~1XT I 

Qk I I ~ancel I I Browse I [2J 

Figure 23. The Button Editor dialog box appears 

3. Edit the Name and Command boxes. 

4. Choose OK. 

Deleting buttons 

You can delete buttons from the Overview display or from the button's 
menu. 

To delete a button while in the Overview display: 

1. Select the button. 

The selected button is highlighted in red. 

2. Choose Delete from the Windows menu (or press the Del key). 

The button is deleted from the room in the Overview display. 
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To delete a button while in a room: 

1. Click once on the button. 

2. Choose Close. 

The button is deleted from the room. 

Creating doors 

Rooms for Windows 

You can create a door that is a direct passage to another room. You create 
doors using the CreatelDelete Door command in the Back Door menu. 

If there is a particular room that you return to frequently, create doors 
for it in each appropriate room or include a door in the Overlay room. At 
any point in your work you can double-click the door and instantly move 
to the room. 

To create a door while in a room: 

1. Click on the Back Door. 

The Back Door menu appears. 

Move 

S~itch To ... 
Qverview 
find 
Windows 
yO To 
~re ate/D e I ete 

Help 

Ctrl+Esc 

Figure 24. The Back Door menu appears when you click the Back Door. 

2. Choose CreatelDelete from the Back Door menu. 

The Create / Delete submenu appears. 
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Create Button 

Uelete Room 

Figure 25. The Create/Delete submenu appears. 

3. Choose Create Door from the CreatelDelete submenu. 

The Choose Room dialog box appears 

Rooms for Windows 

Choose Room 

Overlay 
Overview 
Room 1 

Qk J I ~ancel I 0 
Figure 26. The Choose Room dialog box appears. 

4. Choose the room to which the door will lead. 

5. Choose OK. 

A door appears~ labeled with the name of the room it accesses. 
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Renaming doors 

If you decide that you would like to have a door lead to a different room, 
you can rename the door to change the room it accesses. 

To rename a door while in a room: 

1. Click on the door. 

2. Choose Rename from the displayed menu. 

The Choose Room dialog box appears. 

3. Choose the new room to which the door will lead. 

4. Choose OK. 

The the new room name appears under the door. 

Deleting doors 

Rooms for Windows 

You can delete doors while in the Overview display or by using the menu 
for the door. 

To delete a door while in the Overview display: 

1. Select the door. 

The selected door is highlighted in red. 

2. Select Delete from the Windows menu (or press the Del key) . 

The door is deleted from the room. 

To delete a door while in a room: 

1. Click on the door. 

The door's menu appears. 

2. Choose Close in the door's menu. 

The door is deleted from the room. 
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Mter you have created objects (such as buttons and doors) inside one or 
more rooms, you can manipulate the objects in a variety of ways. You 
can: 

• Copy them to other rooms 

• Move them inside a room or to other rooms 

• Carry them with you as you enter new rooms 

• Duplicate the contents of one or more rooms to another room using 
the Include command 

• Distribute objects to every room by placing them in the Overlay 
room. 

Copied versus included objects 

Objects have different attributes depending on whether they were 
created or opened, copied or included. A copied object is independent 
regarding its position, size, and state. Both the original object and its 
copies can be moved individually in their respective rooms and can be 
positioned and sized independently of each other. 

Included objects are not independent. By contrast, they are identical in 
size, state, and position within all rooms. As seen on the Overview 
display, if an application appears as a minimized icon in the top left 
corner of the Overlay room, identical icons appear in the top left corner 
of all the rooms of the suite. Any change you make to one of these 
included objects affects all occurrences of that object in other rooms. 

All occurrences of copied or included applications will contain the same 
data file. 

You can recognize the different types of objects by their color: 

• Gray objects - Original and copied objects are colored gray. 

• Green objects - Included objects are colored green. 

Any object you select turns red. 
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Copying objects 

In the Overview display, you can copy objects from one room to the next. 
Copying an object allows you to access the same object in another room. 
When you copy an application, you do not start the application again. 
You only make that application available in another room. 

For example, suppose you are creating a memo with a word processing 
application. In the memo, you need to analyze and comment on data 
stored in a spreadsheet application located in another room. If you copy 
the word processing application to the spreadsheet room, your memo is 
conveniently available to edit. 

Refer to "Finding applications" in Section 10 for information about 
locating applications. 

To copy an object, begin in the Overview display: 

1. Select an object. 

2. Choose Copy from the Windows menu, (or press the C key). 

3. Position the outline of the copied object in the room where you want 
the copy, and then click the left mouse button. 

Moving objects 

Rooms for Windows 

Moving an object relocates the object. From the Overview display, you 
can move objects within rooms and from room to room. You can move 
objects around the Overview display using both menu commands and 
the mouse. 

Inside a room, you can move objects using the standard Windows 
desktop techniques. 

To move an object on the Overview display using the mouse: 

1. Point to an object, then press and hold down the left mouse button. 

The object is highlighted and an outline of the object appears at the 
mouse pointer. 

2. Drag the object to a new location in the room or to another room. 

The outline follows the pointer as you move the mouse. 
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3. Release the left mouse button to place the object in the new location. 

To move an object on the Overview display using the Windows menu: 

1. Select an object. 

2. Choose Move from the Windows menu (or press the M key). 

The object is highlighted and an outline of the object appears at the 
mouse pointer. 

3. Point to the new location, and click the left mouse button. 

The object is placed in the new location. 

Carrying objects 

As you move from room to room, you might want to take an object with 
you. Rooms for Windows lets you copy or move objects using the Go To 
command from the Back Door menu so you don't have to go back to the 
Overview to move or copy the object. 

For example, if you're working on a spreadsheet window in one room, 
and you want to use the spreadsheet's data in documents that you'll 
create in a separate word processing room, you can carry the spread
sheet application with you as you go to the new room. 

When you carry an object with you, it is either moved or copied. When 
an object is moved, you carry the single instance of the object with you. 
When an object is copied, the object is copied to the new room, but you 
also leave a copy behind. 

To carry an obj ect as you move to a new room: 

1. Click on the Back Door. 

2. Choose Go To from the Back Door menu. 

3. Choose Room [Copy Objects] to copy objects, or Room [Move 
Objects] to move the objects with you. 

The Go To dialog box appears 

4. Choose a destination room. 
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5. Choose OK. 

A Select. Window dialog box appears and the pointer changes to a 
mouse with a check. 

6. Select each object you want to copy or move using the check pointer. 

The name of the object appears in the dialog box. 

7. Choose OK. 

You go to the room you selected, carrying the selected object(s) along 
with you. 

Including and excluding rooms 

Rooms for Windows 

The Include command lets you include all objects from one room to 
another room. These objects are added to the existing contents of a room. 
You can include the objects from more than one room into a single room. 

Included objects are shared objects, similar to those in the Overlay room, 
and appear in green in the Overview display. Changes that you make to 
an included object apply to all the occurrences of that object. 

Included objects remain in a room until they are deleted or excluded. You 
can undo an inclusion with the Exclude command. 

When you want to see which rooms have been included in another room, 
follow the Exclude procedure to see a list and then select Cancel. 

To include a room, begin in the Overview display: 

1. Click on the title bar of the room to receive the included objects. 

The title bar darkens to show that it is selected. 

2. Choose Include from the Rooms menu. 

A dialog box appears, showing a list of all rooms. 

3. Choose the room whose objects you want to include in the selected 
room from the displayed list. 

4. Choose OK. 

The objects are included, so they are now in both rooms. 
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To exclude a room begin in the Overview display: 

1. Select a room where the objects from another room are included. 

2. Choose Exclude from the Rooms menu. 

The Choose Room To Exclude dialog box appears. 

3. Choose the room whose objects you wish to exclude from the selected 
room. 

4. Choose OK. 

The included objects are removed from the selected room. 

Using the Overlay Room to place objects in rooms 

The Overlay room automatically includes its contents in every other 
room. If you have an application, such as the clock, that you would like 
available in all rooms, put it in the Overlay room. It will be available 
wherever you need it. When you delete an object from the Overlay room 
it is deleted from all the rooms. 

Rooms for Windows - default.ste 
file Booms Windows t!elp 

Figure 27. If you place the Program Manager in the Overlay room, it will be available to start 
programs from any room. 
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13. Accessing DOS from Rooms for Windows 

Rooms for Windows gives you two additional ways to access DOS 
programs: buttons and full screen DOS Rooms. 

Using Buttons with DOS 

One use for buttons is automatically starting DOS applications or 
executing DOS commands. Buttons are handy accelerators for any 
process you run frequently. For example, you can create a button con
taining the DOS command to copy files to a disk as a regular backup 
routine. 

Creating a full screen DOS room 

Rooms for Windows 

Full screen DOS rooms are special rooms dedicated to individual DOS 
applications. Using full screen rooms smoothly integrates DOS applica
tions with your suite and can help keep you from inadvertently starting 
multiple processes. 

When you create a full screen room, it appears in the Overview display 
as a room with a large black area. When you click the title bar, instead 
of entering the room, you move to a full screen DOS application. 

Figure 28. Click the full s~reen room to open a full screen DOS application. 
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Operating in 386 enhanced mode, Microsoft Windows lets you run some 
DOS applications inside windows as well as in the full screen display. 
You can specify this display option in a Windows dialog box. 

However, Rooms for Windows can only make full screen rooms from 
DOS applications that are in the full screen display mode. If you try to 
make a full screen room from a DOS application that is set up to run in 
a window, it makes the room, but it won't function as a full screen room. 
To make a full screen room from a DOS application that is set up to run 
in a window, you must first change its display mode to full screen. 

Caution: When you have a full screen DOS application in a full screen 
room, do not use the Alt+ Enter command to make it run in a window. 
If you do, your full screen room will not work properly. In addition, some 
DOS applications, such as games, may not behave well in Microsoft 
Windows. 

To create a full screen DOS room: 

1. Start a full screen mode DOS application running. 

2. Press Alt+Esc to suspend the application and leave a DOS icon on 
the desktop. 

A DOS icon appears. 

3. Click the DOS icon. 

4. Choose Create Full Screen Room from the DOS icon's menu. 

The DOS icon disappears, and when you move back to the Overview 
display~ a new full screen DOS room appears in your suite. 

To change a DOS application set up to run in a window to a DOS full 
screen application: 

1. Find the minimized icon for the DOS application on the desktop. 

2. Click the application icon. 

3. Choose Settings ... from the menu. 

4. Click the Full Screen button. 

The DOS application can now be run in a full screen room. 
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Terminating DOS Applications before exiting Rooms 

Rooms for Windows 

As with Microsoft Windows, you cannot end a Rooms for Windows 
session until you have individually terminated all running DOS applica
tions. Depending on the specific application, you might have to perform 
different steps to terminate them. 

The preferred method is to leave the DOS application in the manner 
that is normal for the application. This might be done by: 

• Selecting Quit from the application file menu 

• Typing Exit at the DOS prompt 

• Using other methods specific to the application. 

When you return to Rooms for Windows, the application is terminated, 
and the full screen room appears as a regular room with objects included 
by the Overlay room. 

Using Alt+ Esc does not terminate DOS applications. Use the following 
procedure to terminate the DOS application if you cannot terminate it 
in its normal way. 

To terminate DOS applications with the Settings command: 

1. Click the DOS icon. 

The icon'menu appears. 

2. Choose Settings. 

The Settings dialog box appears. 

3. Choose Terminate. 

A warning dialog box appears. 

4. Choose OK. 

The DOS icon disappears. 

To save a suite containing DOS applications: 

1. Choose Save Suite from the File menu. 

2. Answer any Startup information dialog boxes that appear. 
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3. Stop any running DOS applications. 

4. Choose Exit Rooms from the File menu (or press Alt+F4). 

The Save Suite dialog box appears. 

5. Click No. 

Having already saved your suite with your DOS applications run
ning, answering ((No" keeps your suite file from being overwritten as 
the session ends. The next time you load the suite, the DOS applica
tions will be running. 
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14. Tricks and tips for Rooms for Windows 

This section describes some of the tips and tricks you can use to get the 
most out of Rooms for Windows. These ideas were provided by the 
development staff and testers who have been working with Rooms for 
Windows during its development stages. 

Starting Rooms for Windows 

Starting Rooms for Windows automatically - If you want to start 
Rooms for Windows automatically whenever Windows is started, you 
can make the following entry in your WIN.INI file: 

LOAD = pathname ROOMS 

Caution - If you use this technique, do not use the "RUN=" or "LOAD=" 
lines to start additional applications after Rooms for Windows. Use the 
Rooms suite mechanism to start applications. 

Responding to dialog boxes and messages - When a suite is load
ing, if an application needs to query the user through a dialog box or 
message box, Rooms for Windows will wait 60 seconds for you to respond 
to the request. If there is no response, Rooms for Windows will continue 
loading the suite. 

Low on memory 

Suites 

Rooms for Windows 

Close unneeded applications - Open applications that you are not 
using still use memory and Windows resources. If you get into a low 
memory condition, close these unneeded applications to free up memory 
and Windows resources for the applications you are using. 

Create a core suite - Create and save a suite that contains the core 
applications for most suites that you anticipate creating. Add to or 
modify this suite to create a larger suite, and then save the suite under 
another name. 
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Sharing your PC - If you share your PC with other users, you may find 
it more convenient to have separate suites for each user. 

Displaying a Startup dialog box - A window that has been marked 
as "No File" will not prompt again for startup information. To force an 
application to request startup information, when you save the suite, 
close the application and restart it. 

Naming rooms 

Use numbers to arrange room order - In the Overview display, 
Rooms are arranged in alphanumeric order. Enter identifying numbers 
or letters at the beginning of room names to make it easy to define a 
specific room order. 

Long room names truncated in the Overview display - The rooms 
shown in the Overview display get smaller as you add new rooms, so 
long room names will be truncated. If you put an identifying number at 
the start of the room name, such as 1 Project, 2 Project, and so on, you 
will always be able to identify the rooms even as their names are 
truncated. 

Including and excluding rooms 

Checking which rooms have been included - When you want to 
check which rooms have been included in a room, select Exclude in the 
Rooms menu to display a list of Rooms included in the current room. 

The Program Manager 

Use the Program Manager - The use of Program Manager as your 
Window's shell is highly recommended. 

Keep the Windows Program Manager in the Overlay room - This 
automatically places the Program Manager in all the rooms allowing 
you can start new Windows applications from any room. (The first time 
you start Rooms for Windows, the Program Manager appears in Room 
1 and the Overlay room.) 
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The Overlay room 

Putting a favorite application in all rooms - If you have favorite 
applications that you want available in all rooms, put them in the 
Overlay room. Any object you place in the Overlay room is included in 
all rooms. 

Using buttons 

Optimizing your rooms with buttons - The icons you see on a 
Windows desktop represent processes that remain in memory and take 
up valuable Windows resources, even though you've minimized the 
window in which they are running to an icon. 

Rooms for Windows lets you create buttons that reside directly on the 
desktop. The buttons are different from minimized windows because 
they start applications. Because of this feature, you can create rooms 
that only contain doors and buttons. You can use the buttons to start 
applications and open their associated data files. 

Make buttons for applications and documents you use frequent
ly - Instead of leaving applications running in a room, create buttons to 
run them only when you need them. 

Remove or minimize the Program Manager - To setup a room that 
just uses buttons, first remove or minimize the Program Manager in the 
Overlay room. This will reduce the clutter on the desktop. 

Create Program and Document buttons - Create Program buttons 
to start only the applications, and create Document buttons to open 
documents and their associated programs. 

Using doors 

Rooms for Windows 

Placing a door in the Overlay room - If there is a particular room 
that you return to frequently, use the Overlay room to place doors 
leading to it in all the rooms of the suite. It's also convenient to place a 
copy of a door to the Overview display in the Overlay room to make it 
available wherever you are. 
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Navigating 

Using your mouse to get around - Use your mouse to rapidly move 
between rooms and the Overview display. In a room, move the mouse to 
an unoccupied space at the right, left, or top edge of the screen and click 
the left mouse button to move to the next room, previous room, or the 
Overview display. 

Using the Task List - Double-click the left mouse button in the 
background area of a room to display the Windows' Task List dialog box. 
Doors, buttons, and other objects show up in the task list. 

You may see duplicate titles in the Task List because you could have 
several occurrences of the same object running in Rooms. For example 
you could several doors named Room 1 or Overview. 

Using the Go To dialog box - Double-click the right mouse button in 
the background area of a room to display the Go to dialog box. 

Incompatible applications 

Unfriendly applications - Occasionally you may find an application 
that is "unfriendly" in Rooms for Windows. Compatibility problems 
usually center around the ability of Rooms for Windows to properly 
restart the application. 

To solve this problem, first, verify that you are using the proper com
mand line to start the application. If you are, try starting the application 
before you start Rooms for Windows. 

Rooms for Windows treats applications that were running before it is 
started differently from those that are started in Rooms for Windows. If 
this procedure works, the application window will appear in the Overlay 
room and operate properly. 

If the application runs, you can edit your WIN.INI file to include the 
application in the RUN = or LOAD = lines. Make sure Rooms is the last 
item on the line, so it will be run last. The application window will 
appear in the Overlay room each time you start Rooms for Windows or 
load a new suite. 
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Context-sensitive help 28 responding to prompts 63 
Copying Select Window 56 

applications 14 Settings 60 
objects 54,55 Startup information 23 

CreatelDelete submenu 51 Document buttons 44 
Creating creating 47 

applications 43,44 descri ption 44 
buttons 19,43 Doors 8,10 
Document button 48 creating 19,38,43,51 
doors 19, 38,43, 51 deleting 53 
full screen DOS rooms 19,60 getting help 28 
new suites 33 going to a room 39 
objects 43 placing in Overlay room 65 
Program buttons 45 renaming 53 
Rooms 12, 19, 29, 30 using to move to rooms 38 

Creating a room DOS 
Rooms menu 29 accessing 59 
using the Back Door menu 12 assumed familiarity 4 
using the mouse 30 changing the setup 60 

Creating buttons 44 creating full-screen rooms 59 
Creating document buttons 47 keeping applications available 24 
Creating doors 51 selecting Quit 61 
Creating objects 43 starting up applications 23 
Creating program buttons 45 terminating applications 61 
Creating suites 32 typing Exit 61 

using buttons 59 
Double quotes 33 
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applications 40 

26 Full screen DOS rooms Edit menu (Help) 
creating 19,59,60 Editing 

AUTOEXEC.BAT 6 
buttons 50 
WIN.INI file 45,48 G 

Ending a session 22 
Entering a room 36 Generic buttons 44 
Exclude command 57 description 44 
Excluding Getting around 66 

a room 57 using the Go To dialog 66 
rooms 57,58 using the mouse tip 66 

EXE file extension 45 using the Task List tip 66 
Exit Rooms 33 Getting help 
Exit Rooms command 33 on buttons 28 
Exit Windows command 33 on dialog boxes 28 
Exiting on doors 28 

Rooms to Windows 22 on icons 28 
Windows from Rooms 22 on menu commands 28 

Expanding on message boxes 28 
objects 8 pressing F1 28 
windows 8 Glossary command 25 

Glossary terms 27 
Go To dialog box 29 

F Going to a room 
using a door 39 

F1 using the Back Door 38 
using title bar 36 getting help 28 

Going to Using Help going to Using Help 28 
pressing F1 28 File extension STE 35 

File menu 
Exit Rooms command 33 
Exit Windows command 33 H 
Load Suite command 33 
New command 33 Hardware 
Save Suite As command 33 disks 5 
Save Suite command 33 memory 5 

File menu (Help) 26 microprocessor 5 
Find command 40 monitor 5 
Finding mouse 5 

applications 40,42 requirements 5 
from within a room 42 Help 25 
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Back button 26 Ins key to create a room 30 
Bookmark menu 26 Installing Rooms 6 
Browse buttons 26 Introduction to Rooms 2 
context sensitive 28 
control buttons 26 
cross references 27 
description 25 L 
displaying dialog boxes 27 
displaying glossary definitions 27 Load Suite command 33 

Edit menu 26 Loading 

File menu 26 suites 20, 35 

Glossary command 25 Low memory tip 63 

Help menu 26 
How To command 25 
Index button 26 M 
Index command 25 
menu bar 26 
pressing Fl 28 

Marking applications 40 

screen text 27 
Memory Management restrictions 5 

Search button 26 
Menu commands, getting help 28 

terms and graphics 27 
Message boxes, getting help 28 

the help screen 26 
Microsoft Windows 

using 25 
assumed familiarity 4 

Using Help command 25 
required 5 

Help menu 25 
Modifying 

About command 25 
AUTOEXEC.BAT 6 

Glossary command 25 
Mouse 

How To command 25 
creating a room 30 

Index command 25 
moving between rooms 39 

Using Help command 25 
moving through rooms 38 

Help menu (Help) 26 
to move through rooms '38 

How To command 25 
Mouse icon 39 

Hypertext cross references 27 
Moving 

between rooms 11,37,39 
finding applications 36 
from another room 36 

I in the Overview 36 
objects 10,54,55 

Include command 54,57 through rooms 37,38 

Including to a room 10, 37, 40 

a room 14 to an adjacent room 39 

applications 13 to the Overlay room 11 

objects 13, 54 to the Overview 39 

rooms 57 using a dialog box 40 

Index button 26 using doors 37,38 

Index command 25 using Go To dialog box 37 
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using the mouse 37,38 PATH statement, changing 6 

Patterns, changing 31 
PIF file extension 45 

N Placing 
buttons 54 

Navigating 36 doors 54 

New command 33 objects 54 

No File option 23 objects in rooms 54 
Program buttons 44 

BAT file extension 45 
COM file extension 45 

0 creating 45 
descri ption 44 

Objects EXE file extension 45 

carrying 54,56 PIF file extension 45 
copying 54,55 tip for creating 65 
creating 19,43 Program Manager tip 64 
creating applications 19 Project-oriented suites 18 

creating buttons 19 
creating doors 19 
creating windows 19 

Q expanding 8 
including 9,13,54 
moving 54,55 Quick tour 7 

moving to rooms 10 Quitting Rooms 21 

placing in rooms 58 Quitting DOS applications 61 

types of 8 Quitting Rooms for Windows 22 

viewing 8 
Open parentheses 33 
Opening applications 15,19 R 
Overlay room 58,64 

moving to 11 Real Mode restrictions 5 
as part of default suite 8 Rename command 53 
including objects tip 65 
placing doors 65 

Renaming 
doors 53 

Overview rooms 31 
creating rooms 31 Restrictions 5 
excluding rooms 57 
including rooms 57 

memorymgmt 5 

moving through rooms 36 
naming suites 33 

moving to 39 
open applications 5 
Real Mode 5 
shells 5 
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31 
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29 
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29 

creating with CreatelDelete Room 29 
creating with Ins key 29 
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default directory 
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exiting to Windows 
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hardware requirements 
in a suite 
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including tip 
installing 
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11,37 
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29 
64 
36 
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welcome to 1 
working with 18 

Rooms menu 29 
RunningSETUP.EXE 6 
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Save Suite As command 33 
Save Suite command 33 
Saving 

a suite 34 
suites 20, 61 

Screen text 27 
hel p cross references 27 

Search button 26 
Select Window dialog box 56 
Setting up Rooms 19 
Settings 

dialog box 60 
SETUP.EXE 6 
Shell restrictions 5 
Showing applications 42 
Single quotes 33 
Software 

Microsoft Windows 3.0 5 
requirements 5 

Spaces 33 
Specifying 

a data file 24 
No File 23 

Start up information 22,23 
Starting 

in a room 21 
in a suite 21 
Rooms 21 
Rooms from DOS 21 

Starting from Windows 7,21 
Starting tip 63 
Startup 

data files 23 
DOS applications 23 
No File option 23 

Startup information dialog box 24 
Suite name 21 
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creating new 33 
default suite 32 
displaying Startup tip 64 
illegal characters 33 
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not using close parentheses 33 
not using double quote 33 
not using open parentheses 33 
not using single quote 33 
not using spaces 33 
project-oriented 18 
saving 20,34,61 
sharing PC tip 64 
STE file extensions 35 
task-oriented 18 

T 

Task-oriented suites 18 
Terminating DOS applications 61 
Terms 27 
Title bar 
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Tricks and tips 63 
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Using 
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